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How	to	open	olm	file	on	mac

MS	Outlook	for	Mac	stores	the	data	of	the	users	in	'Data	Records	Folder',	which	is	different	in	case	of	Outlook	for	Windows	that	uses	PST	file	format	for	their	storage.	In	order	to	export	the	data	from	Outlook	Mac,	we	need	to	use	the	'Export'	option	in	Mac	Outlook	that	will	create	the	OLM	file	containing	Mac	messages,	contacts,	calendar	PDF,	RTF
format,	Calendar,	and	all	other	data	Microsoft,	to	facilitate	Exchange	connectivity.	This	blog	guides	you	on	a	quick	way	to	open/import	Outlook	for	Mac	file	to	Windows	Outlook.	Steps	to	Manually	Convert	OLM	File	To	PST	Format	If	you	want	to	convert	OLM	file	to	PST	format,	then	the	user	needs	to	locate	the	OLM	file	on	the	system.	We	have
mentioned	two	ways	to	locate	the	file	below:	Documents\Microsoft	User	Data\Office	2011	Identities\Main	Identity\Databases	Or,	Documents\Microsoft	User	Data\	MS	Office	2011	Identities\Main	Identity\Data-Records\Message	By	following	the	above	steps,	you	cannot	locate	the	OLM	file	present	on	the	system.	To	access	the	file,	you	need	to	create	it
by	saving	the	mailbox	files	in	the	OLM	format.	Below	we	have	mentioned	the	steps:	Click	on	File	»	Select	Export.	Choose	the	files	displayed	on	the	screen.	Then,	a	new	option	'Delete	Items	After	Exporting'	appears	on	the	screen.	Now,	check	the	'Do	Not	Want	To	Delete	The	Item'	option.	Save	the	file	and	browse	to	the	destination	location.	After
creating	the	OLM	files,	the	files	can	be	converted	into	PST	format	using	the	below-mentioned	steps:	Step	1:	Create	a	Gmail	account	Step	2:	Set	up	Outlook	for	Mac	with	Gmail	Open	Outlook	and	click	on	Tools	>	Accounts.	Click	on	the	'+'	button	to	create	a	new	account.	Select	the	email	address	and	fill	your	details	for	Gmail	account.	Now,	enter	the
details	of	password,	email	address,	and	user	name	for	Gmail	account	Enter	the	'Incoming	server'	as	'imap.gmail.com'	Choose	the	option	'Use	SSL	connect'	Now,	enter	the	Outgoing	Server	as	'smtp.gmail.com'	Then,	enter	the	'Outgoing	port'	carefully	as	465	and	click	on	the	'Add	account'	option.	Step	3:	Export-Mailbox	Files	From	Outlook	To	Gmail
Right-click	on	the	file	you	want	to	export	and	click	on	the	'Copy'	option.	Choose	the	destination	folder	in	the	Gmail	account.	The	navigation	tab	shows	the	uploading	messages.	Refresh	your	account,	once	the	messages	upload.	Step	4:	Set	Up	Gmail	Account	With	Outlook	Open	Windows	Outlook	and	click	on	File	>	Info	>	Account	Settings	Click	on	the
'New'	icon	option.	Check	carefully	the	'Additional	Server	Type'	Check	the	'Internet	E-mail'	option	Enter	the	details	such	as	password,	email	address,	and	user	name.	Choose	the	account	type	as	'IMAP'.	Select	the	'Incoming	Server'	as	'imap.gmail.com'	Enter	the	'Outgoing	Server'	as	'smtp.gmail.com'	Click	on	the	'More	Settings'	option.	From	the
'Outgoing	Server'	option,	click	on	the	'My	Outgoing	server	requires	authentication'	option.	From	the	'Advanced'	option,	enter	the	'Incoming	Server	Port'	as	'993'.	Click	on	th	Encryption	Type	as	'SSL'	Enter	Outgoing	Server	Port	as	'465'.	Click	on	the	'OK'	option.	Select	the	'Test	Account	Settings'	option	and	click	on	the	'Finish'	option.	Step	5:	Export-
Mailbox	File	from	Gmail	to	Windows	Outlook	Open	your	Gmail	account	and	click	on	the	'Settings'	option.	Click	on	the	'Forwarding	and	POP/IMAP'	option.	From	the	'IMAP	Access'	and	click	on	the	'Enable	IMAP'	option.	Now,	enable	the	'Auto-Expunge	On'	option.	Then	carefully	enable	the	'Archive'	option.	Click	on	the	'Save	Changes'	option.	Open
Outlook	and	click	on	the	'Send/Receive	message'	option.	Opt	For	A	Reliable	Way	To	Convert	OLM	Files	To	PST			Ensure	that	you	opt	for	a	reliable	and	professional	method	to	perform	the	conversion	that	is,	OLM	to	PST	software.	The	tool	has	advanced	features,	which	enables	the	user	to	export	OLM	files	safely	to	PST	format.	The	user	can	successfully
extract	data	from	OLM	to	PST	type	without	changing	the	hierarchy	of	the	folder.	The	user	can	import	files	on	Office	365	and	a	Live	Exchange	Server.	The	user	can	recover	the	entire	data	from	OLM	files	to	multiple	file	formats	such	as	EMLX,	PDF,	HTML,	EML,	MBOX,	vCal,	and	etc.	The	OLM	tool	supports	all	edition	of	MS	Outlook	including	2007,
2010,	2013,	2016,	2019,	Mac	Outlook	2019,	2016,	2011.	The	OLM	file	type	is	primarily	associated	with	Microsoft	Outlook.	OLM	files	mostly	belong	to	Microsoft	Outlook	by	Microsoft.	OLM(Outlook	For	Mac)	is	a	binary	database	file	format	developed	by	Microsoft	for	Outlook	For	Mac,	and	is	proprietary	software.	OLM	files	have	the	MIME-type
Application/octet-stream	and	are	designed	as	database	files	that	store	entire	Outlook	profiles	and	their	data.	An	OLM	file	contains	emails,	contacts,	calendars,	tasks,	notes,	etc.	The	default	storage	location	of	OLM	storage	files	on	Mac	is	~/Document/Microsoft	User	Data/	Office	2011	Identities/	Main	Identity/	Data	Records/.	OLM	files	do	not	have	a
maximum	size	limit,	but	tend	to	get	corrupted	when	they	exceed	2GB.	There	are	tools	that	can	repair	corrupt	OLM	files	including	OLM	File	Repair	Tool,	Stellar	OLM	Repair	and	OLM	Recovery	Tool.	Only	Outlook	For	Mac	can	safely	open	OLM	files.	To	open	OLM	files	in	Outlook	for	Windows,	the	file	must	first	be	converted	to	PST,	the	file	format	used
on	Windows.	Programs	that	can	view	OLM	files	on	Mac	include	OLM	Viewer	and	OLM	Reader	for	Mac	OS.	OLM	files	can	be	converted	into	multiple	formats	by	converter	programs	which	include	OLM	to	PST	Converter	and	OLM	Extractor	Max.	Outlook	2011	for	Mac	can	import	OLM	files	and	export	them	into	various	other	file	types	such	as	CSV.	Other
files	associated	with	OLM	include:	PST,	OLK,	OST,	CSV	How	to	open	an	OLM	file	You	need	a	suitable	software	like	Microsoft	Outlook	from	Microsoft	to	open	an	OLM	file.	Without	proper	software	you	will	receive	a	Windows	message	"How	do	you	want	to	open	this	file?"	or	"Windows	cannot	open	this	file"	or	a	similar	Mac/iPhone/Android	alert.	If	you
cannot	open	your	OLM	file	correctly,	try	to	right-click	or	long-press	the	file.	Then	click	"Open	with"	and	choose	an	application.	You	can	also	display	a	OLM	file	directly	in	the	browser:.	Just	drag	the	file	onto	this	browser	window	and	drop	it.	Online	OLM	Text	Viewer	Choose	your	.olm	file	to	analyze	Read	our	privacy	guarantee	in	Filext’s	terms	and
privacy	policy	an	olm	database	file	is	a	special	file	format	by	Microsoft	and	should	only	be	edited	and	saved	with	the	appropriate	software.	How	to	solve	problems	with	OLM	files	Associate	the	OLM	file	extension	with	the	correct	application.	Update	your	software	that	should	actually	open	database	files.	Because	only	the	current	version	supports	the
latest	OLM	file	format.	Search,	therefore,	e.g.	on	the	Microsoft	manufacturer	website	after	an	available	Microsoft	Outlook	update.	To	make	sure	that	your	OLM	file	is	not	corrupted	or	virus-infected,	get	the	file	again	and	scan	it	with	Google's	virustotal.com.	Summary:		OLM	files	are	only	accessible	with	Microsoft	Outlook	for	Mac,	but	If	you	want	to
open	your	OLM	file	in	Windows	platform	like	Excel,	Outlook,	Thunderbird,	Windows	Live	Mail,	etc.	then	this	is	not	an	easy	task.	This	section	will	help	you	to	import	the	OLM	file	into	Excel	so	that	you	can	open,	view,	and	read	your	crucial	data	in	various	OLM	files	on	Windows.	Need	to	Import	OLM	file	to	Excel	CSV	Contacts	are	easy	to	access	in	any
spreadsheet	programs	such	as	Excel,	Google	Spreadsheets,	etc.A	CSV	file	is	easily	importable	into	any	email	services	of	an	email	client.Users	can	store	unlimited	contacts	in	the	CSV	file	with	details.	Before	proceeding	further	let’s	have	a	short	intro	of	OLM	and	CSV	File	formats.	OLM	File:	This	file	format	preserve	email	messages,	Mac	Outlook
permits	the	users	to	convert	their	database	in	OLM	file	format.	It	can	accumulate	multiple	items	like	email	folders,	address	books,	etc.	CSV	File:	A	Comma	Separated	Values	(CSV)	can	only	preserve	data	like	number	or	text	in	plain	text	but	it	is	one	of	the	useful	file	formats	to	preserve	countless	contacts.	User	can	access	the	data	of	their	CSV	file	in
any	spreadsheets	programs	like	MS	Excel	or	Google	Spreadsheets,	etc	Import	OLM	file	to	Excel	Manually	Import	your	OLM	file	to	Mac	Outlook	from	Import/Export	MenuOnce	your	OLM	data	we	imported	into	Outlook	then	again	tap	on	Import/Export	optionChoose	“Export	to	a	File”	option	from	Import	and	Export	WizardSelect	Comma	Separated	value
and	hit	NextBrowse	the	destination	location	for	your	resultant	CSV	fileHit	Finish		Consequences	of	using	Manual	method	The	manual	method	only	allows	you	to	convert	OLM	contacts	to	contacts.	Does	not	allow	you	to	convert	other	data	from	OLM	data	to	CSVIt	is	a	very	complicated	and	time-consuming	methodOutlook	Installation	must	be	required	
Import	OLM	File	to	Excel	using	a	Professional	Approach	Download	and	launch	Outlook	Mac	Exporter	Tool	Click	on	Add	File	button	to	add	the	OLM	file	into	the	software	Choose	CSV	File	format	from	Export	type	Browse	the	convenient	folder	for	your	resultant	file	Click	on	the	Export	button	to	initiate	the	process	Wait	for	a	while	till	the	software
finished	the	conversion	process	and	then	find	the	destination	folder	and	access	your	resultant	CSV	File.	Additional	Highlights	of	the	Tool	If	you	need	to	launch	the	OLM	file	in	Excel,	first	you	have	to	export	the	OLM	file	into	CSV	file	format.	So	we	provide	you	an	amazing	third-party	tool	so	that	users	can	use	this	in	case	of	instant	conversion	or	manual
method	lacks	due	to	some	reasons.	By	using	the	above	methods	user	can	directly	import	OLM	files	to	excel.	This	tool	consists	up	of	many	advanced	features	some	of	them	are	listed	below:	It	allows	you	to	convert	emails,	contacts,	and	calendars	into	more	than	8	file	formats.Permits	you	to	export	more	than	one	Outlook	contacts	from	the	OLM
file.Grants	data	filter	option	to	import	selective	OLM	file	into	Excel.Authorize	you	to	instantly	preview	your	selective	OLM	file	before	conversion.Tool	additional	assist	you	to	convert	OLM	file	to	MBOX	formatSupport	all	the	latest	versions	of	Windows	OS.	Final	Words	The	automated	Tool	is	fully	verified	by	our	experts	and	one	can	easily	import	OLM
file	to	Excel	in	a	trouble-free	manner.	This	tool	is	very	easy	to	use	and	has	many	additional	features;	some	of	them	are	described	above.	If	the	user	needs	to	convert	OLM	to	CSV	on	Mac	urgently	then	we	advise	you	to	use	the	third-party	tool	which	is	defined	above.	Rohan	Wiese	❘		July	10th,	2018	❘	0	Comments	We	can	use	Microsoft	Outlook	email
client	on	both	MAC	and	Windows	platform.	Both	these	platforms	are	similar	but	the	only	difference	between	them	is	the	file	format	used	by	them	for	storage	of	data.	On	Mac,	OLM	files	are	used	for	storage	while	PST	files	are	used	on	Windows.	But	if	you	want	to	access	your	Mac	Outlook	data	on	Windows,	you’ll	have	to	switch	from	Outlook	for	Mac
OLM	into	Outlook	PST	for	Windows.	There	is	not	any	method	to	export	or	Open	Outlook	for	Mac	OLM	file	into	Windows	Outlook	PST	file	format.	For	accessing	your	Mac	data	on	Windows	i.e.	files,	contacts,	calendars,	events	etc,	first	you	have	to	convert	OLM	file	to	PST	format	and	then	import	this	PST	file	to	Windows	Outlook.	Although	it	can	be	done
manually,	but	if	not	done	in	a	right	way,	it	may	lead	to	data	loss.	An	user	may	experience	issues	during	OLM	to	PST	conversion.	So,	it	is	recommended	to	use	a	third	party	tool	so	that	the	data	remains	intact.		Also	Read:	How	to	Export	Apple	Mac	Mail	(MBOX)	to	MS	Outlook	Manual	Steps	to	Open	Outlook	for	Mac	OLM	File	to	Windows	Outlook	For
manual	conversion,	you	have	to	locate	the	physical	OLM	file	first.	You	can	find	the	OLM	files	on	either	of	the	following	two	locations.	Documents\Microsoft	User	Data\Office	2011	Identities\Main	Identity\Databases	Documents\Microsoft	User	Data\MS	Office	2011	Identities\Main	Identity\Data-Records\Message	Instead,	you’ll	have	to	create	it	by	saving
the	mailbox	data	in	the	OLM	format.	Follow	these	steps-	In	the	drive	location	which	is	indicated	above,	click	on	File	and	then	Select	Export.	A	new	window	will	be	opened.	Select	all	the	data	being	shown.	A	new	option	“Delete	items	after	exporting”	appears.	Check	“Do	not	want	to	delete	item”	option.	Now	“Save	As”	option	will	appear.	Select	the
Destination	Location	where	you	want	to	save	your	OLM	File	Click	on	Save.	Now,	once	you	have	created	OLM	file,	it	can	be	converted	to	PST	by	using	below	steps.	Create	IMAP	email	account-	IMAP	acts	as	an	intermediate	server	between	Mac	Outlook	and	Windows	Outlook.	Gmail	is	the	best	platform	for	creating	an	IMAP	account.	Once	it	is	created,
follow	these	steps-	Step	1:	Click	the	gear	button	on	the	top	right	corner	and	go	to	settings.	Step	2:	On	the	settings	page,	click	Forwarding	and	POP/IMAP	tab	appearing	at	the	top.	Step	3:	Check	your	IMAP	status.	If	it	is	disabled,	enable	it.	Click	Save	changes.	Your	IMAP	account	is	created.	Now,	you	have	to	set	up	your	Mac	Outlook	to	IMAP	account.
Proceed	with	these	steps	to	do	this.	Step	1:	Open	the	Outlook	for	Mac.	On	the	Menu	bar,	go	to	Tools	and	then	Accounts.	Step	2:	On	the	Accounts	window,	click	Email	and	enter	your	Email	account	information	i.e.	Email	address	and	Password.	Now,	click	Add	Account.	Step	3:	Your	IMAP	mail	account	will	be	successfully	added.	Create	a	Gmail	Label
Step	1:	Log	in	to	your	gmail	account.	Step	2:	Go	to	settings	page	and	click	Labels	at	the	top	of	the	task	bar.	Step	3:	Now	click	create	new	label	button.	Step	4:	On	the	new	label	dialog	box,	enter	the	name	of	your	new	label	and	click	create.	Make	sure	show	in	IMAP	box	is	checked.	Step	5:	Now	go	to	your	Mac	Outlook	and	click	on	Send/receive	button
to	update	the	IMAP	mailbox.	Migrate	emails	from	Mac	Outlook	to	IMAP	It	is	very	important	part	of	the	process	in	which	your	mailbox	data	of	an	OLM	file	will	be	transferred	to	IMAP	mailbox.	Step	1:	Launch	Outlook	for	Mac	on	your	system.	Step	2:	Right-click	the	mailbox	item	you	want	to	move.	Click	Move,	then	click	on	Copy	to	folder.	Step	3:	Name
the	IMAP	folder	you	want	to	copy	and	then	click	Copy.	Step	4:	Now,	update	your	Mac	Outlook	IMAP	data	by	clicking	Send/receive	button.		Also	Read:	How	to	Export	Emails	from	Thunderbird	to	MS	Outlook	By	this,	all	the	emails	and	other	mailbox	items	get	synced	with	IMAP	mailbox	folder.	Now,	move	all	the	mailbox	data	from	IMAP	mailbox	folder	to
Windows	Outlook.	You	need	to	set	up	the	very	same	IMAP	Mail	account	to	the	Windows	Outlook	also.	Now,	drag	your	IMAP	mailbox	folder	data	to	Windows	Outlook	Inbox	Folder.	Concluding	words	However,	you	can	use	this	manual	method	to	open	Mac	Outlook	in	Windows	Outlook.	But,	this	method	is	little	risky	and	time	consuming.	It	may	also
require	some	technical	knowledge.	So,	a	non-tech	user	might	face	problems.	Also,	a	small	mistake	may	result	is	data	loss.	So,	in	order	to	perform	safe	and	reliable	transformation	emails	from	Mac	Outlook	OLM	file	to	Windows	Outlook	PST	,	it	is	recommended	to	use	a	third	party	OLM	to	PST	Converter	tool.	It	also	handle	corrupt	OLM	files	too,	and
convert	them	into	PST	and	other	popular	email	formats,	such	as	MSG,	EML,	and	MBOX.	Download	Now	Realted	Post
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